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1. INTRODUCTION  

 Scope 

This document describes an application’s example for the Telit Charlie board, which is 

used to detect a freefall.  All the features and solutions described in this document are 

applicable to Telit Charlie Evaluation Kit. 

 Audience 

This document is intended for Telit customers, especially system integrators, about to 

implement their applications using the Telit Charlie Evaluation kit. 

 Contact Information, Support 

For general contact, technical support services, technical questions and report of 

documentation errors contact Telit Technical Support at: 

• TS-EMEA@telit.com 
• TS-AMERICAS@telit.com 
• TS-APAC@telit.com 
• TS-SRD@telit.com 
• TS-ONEEDGE@telit.com 

Alternatively, use: 

https://www.telit.com/contact-us/ 

 

For detailed information about where you can buy the Telit modules or for 

recommendations on accessories and components visit: 

https://www.telit.com  

Our aim is to make this guide as helpful as possible. Keep us informed of your comments 

and suggestions for improvements. 

Telit appreciates the user feedback on our information. 

  

mailto:TS-EMEA@telit.com
mailto:TS-AMERICAS@telit.com
mailto:TS-APAC@telit.com
mailto:TS-SRD@telit.com
https://www.telit.com/contact-us/
https://www.telit.com/
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 Symbol Conventions 

 

 

Danger: This information MUST be followed or catastrophic 

equipment failure or personal injury may occur. 

 

 

Warning: Alerts the user on important steps about the module 

integration. 

 

   

Note/Tip: Provides advice and suggestions that may be useful when 

integrating the module. 

 

 

Electro-static Discharge: Notifies the user to take proper grounding 

precautions before handling the product. 

Table 1: Symbol Conventions 

All dates are in ISO 8601 format, that is YYYY-MM-DD. 

 Related Documents 

• ME310G1/ME910G1/ML865G1 AT commands Reference Guide, 80617ST10991A 

Rev.9 

• Charlie EVK HW User Guide, 1VV0301670 Rev. 5 

• LwM2M AT Commands Reference Guide, 80529ST10974A Rev. 4 

• How to generate freefall interrupt using BMA400, Bosch Sensortec 
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2. PREREQUISITES 

 Hardware 

You need a Telit Charlie board, a cellular antenna and a micro-USB cable. The Telit 

Charlie Evaluation kit can be found at https://www.telit.com/developer-zone/charlie/. 

 

               The Charlie Board Evaluation Kit comes with the Hardware User Guide.  

                Please read carefully the Charlie’s HW User Guide first. 

 

 Software 

The software used are Arduino IDE version 1.8.15 and a serial terminal tool (i.e. Tera 

Term). Telit AT Controller (TATC) is recommended, please download it from  

https://telit.com/developer-zone/charlie/ 

You also need a browser to connect the board with OneEdge. 

 

 

https://www.telit.com/developer-zone/charlie/
https://telit.com/developer-zone/charlie/
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3. SETUP SOFTWARE 

Dowload the Arduino IDE and the Arduino library for Telit module ME310G1 at  

https://github.com/telit/arduino-me310-library.  

Download the Grove_3Axis_Digital_Accelerometer_BMA400 library from  

https://github.com/Seeed-Studio/Grove_3Axis_Digital_Accelerometer_BMA400. 

 

To add the Charlie Board on Arduino IDE, click on File->Preference. Enter the release 

link into Additional Board Manager URLs field: 

https://raw.githubusercontent.com/telit/arduino-charlie/main/Arduino/package_Telit-

board_index.json.  

Click on Tools->Boards…->Boards manager and install Charlie platform. Select your 

Charlie board from Tools->Board after installation. 

To add the library for the accelerometer, go on Sketch->Include library->Add .ZIP Library  

and select the folder or ZIP file which would you import. 

https://github.com/telit/arduino-me310-library
https://github.com/Seeed-Studio/Grove_3Axis_Digital_Accelerometer_BMA400
https://raw.githubusercontent.com/telit/arduino-charlie/main/Arduino/package_Telit-board_index.json
https://raw.githubusercontent.com/telit/arduino-charlie/main/Arduino/package_Telit-board_index.json
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4. SETUP IOT PORTAL ONEEDGE 

To manage the module through the IoT portal it is necessary to have an account on 

OneEdge IoT platform. 

 Register your account 

Go to https://portal-dev.telit.com/app/login . 

 

Figure 1: Log in page 

 

If you have an account, skip this and continue to read from 4.2 Setup the thing definition 

and device profile. 

Click on “Create account”, enter your email and then look for an activaction link in your 

email folder. 

https://portal-dev.telit.com/app/login
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Figure 2: Activation link 

Click on link or copy and paste the link to your browser. The following form will appear 

 

 

Figure 3: Account creation 

The fields marked with * are mandatory. Please make sure all fields are correctly filled. 
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Organization names may be duplicated.  

                                        Organizaton keys are unique, please choose a different key value 

 

 

Then accept privacy policy and Terms and Conditions. 

 Setup the thing definition and device profile 

Thing definition and device profiles define which capabilities are provided by the device. 

Specifically, the device profile provides all the information to bind the LwM2M object to 

the real properties, events and commands- the device data model. 

 

4.2.1. Import the Thing definition 

Click on tab Developer. 

 

Figure 4: Menu tabs IoT portal 
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Click on Thing definition on the left menu. 

 

Figure 5: Left menu Thing definition 

Click on tab Import. 

 

Figure 6: Import Thing definition 
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In the next page, click on Attach file and select the file thing_defs.json. Then click on 

Import button. 

 

 

Figure 7: Attach file and Import buttons 

 

Note- Please make sure that the JSON file imported on the thing definition is 

reporting “thing definition” and not “device profile” in the name. 

 

 

4.2.2. Import Device profiles 

Go back on Developer section and select Device profiles from the left menu. In the next 

page click on Import. 

 

Figure 8: Import Device profile 

Like in the step about Thing definition, click on Attach files and select the file 

LwM2M_profiles.json. Then click on Import button. 

Now in the list of Device profiles will appear the Charlie_profile. Click on Edit button 

(marked in green in Figure 9) and check that the device profile objects are properly 

registered. 

 

Figure 9: Device profile imported 
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4.2.3. Import Trigger 

On Developer page, click on Trigger from left menu. From this page, click on Actions and 

from the drop down menu choose Import. Click on Attach files button, upload the file 

triggers.json and after that, click on Import. 

 

Figure 10: Trigger import 

In the Triggers Table, the new Trigger is not running: click on the last symbol (tick symbol) 

to make it run. The tick symbol will be replace by the cross symbol. 

Then click on second symbol Edit. In the next page click on  2.email.send button and then 

on pencil symbol 

 

Figure 11: email.send editing 

In the next window, replace the field To with your email and then click on Add button. 

After that, click on Update button. 
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Figure 12: Update button 

4.2.4. Create a new Thing 

Before operating with the IoT portal, it is necessary to create a new Thing on the portal. 

The procedure is available at: 

https://docs.devicewise.com/Content/Products/Management_Portal/Things/Creating-

a-thing-for-a-Telit-module.htm  

In point 4 of the guide reported in the link above, in field Thing definitions choose 

ME310G1-WW, which has the alarm interruptStatus. 

In point 8 select the Device profile Charlie_profile. 

https://docs.devicewise.com/Content/Products/Management_Portal/Things/Creating-a-thing-for-a-Telit-module.htm
https://docs.devicewise.com/Content/Products/Management_Portal/Things/Creating-a-thing-for-a-Telit-module.htm


                  

                Telit Charlie Evaluation Kit. Application example 

 

 

 

80xxxNT1yyyyA  Page 16 of 40 2021-07-20 

Not  Subject to NDA 

5. CONNECT CHARLIE BOARD TO IOT PORTAL 

 Disable WWAN connection in Windows 

 

 

Windows 10 users: by default, the OS is detecting and taking control of ME310 

cellular connection. Please ensure this option is disabled as described in the 

following paragraph. 

 

Whenever the Charlie Board is set up with a valid APN, Windows 10 network manager is 

able to detect this valid configuration and can automatically start a Dial-up connection as 

soon as the module is connected to the PC. 

In this scenario the context is already enabled by Windows, the agents inside the module 

will get an error when trying to perform any connection using the same PDP context. 

To avoid this scenario, it’s necessary to disable the network adapter at runtime or change 

the default setting in the Windows registry. 

5.1.1. Disable network adapter at runtime 

• Open the Device Manager windows tool 

• Open “Network adapters” section 

• Search for “Telit USB WWAN Adapter” element 

• Right-click and disable the device 
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Figure 13: Network adapter disable 

This setting is applied only to the device currently connected to the computer, so the user 

should repeat this procedure for all new devices connected to the computer. 

 

 Telit AT Controller 

After the installation, double click on Telit AT Controller icon to open the application. 

                                                                 

Figure 14: Telit AT controller icon 
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Click on the icon marked in red. 

                  

Figure 15: Setting icon 

 

In the next window, set the parameters like in Figure 14. Then click on OK button 
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Figure 16: Setting window 

 

Upon configuration, click on Connect button  

                                                                              

Module information such as IMEI, Manufacter name, Model name an FW release will be 

displayed 
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Figure 17: Setup completed 

Then click on AT Terminal button 
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Figure 18: AT Terminal console 

 Connection to the IoT portal 

The LwM2M client requires an active connection in order to be able to start the LwM2M 

handshake with the server and perform following interactions. 

In case the LwM2M client is enabled before having an active connection, it will stay on 

hold until  data connection is active. 

From a serial terminal, send the following AT commands: 

• AT+CGDCONT=1,”IP”,”YOUR_APN”, to set the PDP context to be used by the 

LWM2M client 

• AT#SGACT=1,0, to let the LWM2M client handle the connection and the PDP 

context startup 

• AT#LWM2MENA=1 (refer to AT#LWM2MENA=<en> on the AT commands 

reference guide.) 
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The LwM2M client will perform the Bootstrap (only the first time or when forced) and the 

terminal will receive the following URC: 

 

LWM2M-TLT: “BOOTSTRAPPING”,SSID=0,”coaps://bs.telit.io” 

LWM2M-TLT: “BOOTSTRAPPED”,SSID=0,”coaps://bs.telit.io” 

 

After the Bootstrap, the LwM2M client will perform the registration on the DM server, 

and if the service is enabling through AT#LWM2MW=0,33211,0,0,1,1 command, the 

following URC are received: 

 

LWM2M-TLT:”REGISTERING”,SSID=99,”coaps://api-dev.devicewise.com” 

LWM2M-TLT:”REGISTERED”,SSID=99,”coaps://api-dev.devicewise.com” 

 Add the object 3200 

Next step is to add the object 3200 to the client. It corresponds to a digital pin which was 

used to detect the interrupt generated by the freefall and for schedule the procedure to 

send the email. In the folder you will find the file object_3200.xml. 

On module ME310G1 add the object 3200 with the followings AT commands: 

1. AT#M2MWRITE=”/XML/object_3200.xml”, size 

 

Figure 19: Parameters for AT#M2MWRITE 
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2. After the command AT#M2MWRITE, there will be the symbol >>>. It indicates that 

the module is waiting for the upload of the file .xml. Click on the button marked in 

red in Figure 15 and select the file object_3200.xml  

 

Figure 20: Uploading the file objct_3200.xml 

 

3. AT#REBOOT 

4. AT#M2MLIST=/XML/ to verify if the file is uploaded 
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Figure 21: List of the files in the directory XML 

 

5. AT#LWM2MENA=1 

6. On the portal there will be the object 3200 

7. Create an object instance through AT#LWM2MNEWINST=0,3200,0 

8. Reload the object browser page (click on tab LWM2M from main page and then on 

Object browser) 
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Figure 22: Object 3200 on the IoT portal 

 

Then you have to change the value of the Lifetime parameter from 60 to 120. To do that, 

from module main page, click on tab LwM2M and then on Object browser.  

 

Figure 23: LWM2M page 
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On Object browser page, click on LwM2M Server and then on Write button in field 

Lifetime. 

 

Figure 24: LwM2M Server object 

 

 

Figure 25: Lifetime field 

Click on Update button to update the value. 
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6. DETECTING A FREEFALL WITH CHARLIE BOARD 

For the example described in this chapter, there are two variants: one for product 2G and 

one for product 4G. 

 

                It is necessary to select the wireless technology that will be used.    

                Please read the AT commands reference guide regarding the command 

                AT+WS46. 

 

 Select the wireless technology 

To select the wireless technology, from a serial terminal send to the module the following 

command 

• AT+WS46= 12 if you want to use 2G technology 

• AT+WS46= 28 if you want to use 4G technology 

 

After you send the command, the module needs a reboot to store in the memory the 

select wireless technology. To do that, send the AT command AT#REBOOT. 

 Detecting freefall with Charlie Board 

On Arduino IDE, go to File->Examples->ME310G1  and select which sketch would you use.  

 

 

Warning: if your SIM needs the PIN code, you need to change the char pin[] 

variable value XXXX with your PIN code in both Arduino sketches. 

 

 

Upload the sketch on Telit Charlie. After done uploading, open the serial monitor to trace 

the application’s flow. 
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Figure 26: Serial monitor Arduino IDE 
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Figure 27: Execution flow 
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Figure 28: Execution flow (2) 

Verify on IoT portal that client is registered to the server. In Figure 29, this is visible in 

field Last Seen, in which the green clip indicates the registration. If the client is not 

registered to the server, the clip will be red. 
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Figure 29: Registration on IoT portal 

 

Note that in Figure 29 the alarm status is set to false. 

 

When the freefall occurred (like in Figure 28), the MCU will send the command 

AT#LWM2MENA=1,1 to enable the client registration. Then on IoT portal there will be the 

situation illustrated in Figure 29. 

 

In GPS priority, the client perform a LwM2M read operation every 10 seconds on resource 

6/0/3, corresponding to GPS accuracy, until the reosurce value is below 20.0000. 

When the value is below 20.0000, the pririty is switche to WWAN, licke in Figure 28. 

 

 

Figure 30: Priority switched to WWAN 
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On portal side the situation is 

 

Figure 31: Alarm true 

 

 

Figure 32: GPS fix  

 

 

Figure 33: Email sent with the GPS coordinates 
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Figure 34: Execution flow (4) 
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7. PRODUCT AND SAFETY INFORMATION 

 Copyrights and Other Notices 

SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE 

Although reasonable efforts have been made to ensure the accuracy of this document, 

Telit assumes no liability resulting from any inaccuracies or omissions in this document, 

or from the use of the information contained herein. The information contained in this 

document has been carefully checked and is believed to be reliable. Telit reserves the 

right to make changes to any of the products described herein, to revise it and to make 

changes  from time to time without any obligation to notify anyone of such  revisions or 

changes. Telit does not assume any liability arising from the application or use of any 

product, software, or circuit described herein; neither does it convey license under its 

patent rights or the rights of others. 

This document may contain references or information about Telit’s products (machines 

and programs), or services that are not announced in your country. Such references or 

information do not necessarily mean that Telit intends to announce such Telit products, 

programming, or services in your country. 

7.1.1. Copyrights 

This instruction manual and the Telit products described herein may include or describe 

Telit copyrighted material, such as computer programs stored in semiconductor 

memories or other media. The laws in Italy and in other countries reserve to Telit and its 

licensors certain exclusive rights for copyrighted material, including the exclusive righ to 

copy, reproduce in any form, distribute and make derivative works of the copyrighted 

material. Accordingly, any of Telit’s or its licensors’ copyrighted material contained 

herein or described in this instruction manual, shall not be copied, reproduced, 

distributed, merged or modified in any way without the express written permission of the 

owner. Furthermore, the purchase of Telit products shall not be deemed to grant in any 

way, neither directly nor by implication, or estoppel, any license.  

7.1.2. Computer Software Copyrights 

Telit and the Third Party supplied Software (SW) products, described in this instruction 

manual may include Telit’s and other Third Party’s copyrighted computer programs 

stored in semiconductor memories or other media. The laws in Italy and in other 

countries reserve to Telit and other Third Party, SW exclusive rights for copyrighted 
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computer programs, including – but not limited to -  the exclusive right to copy or 

reproduce in any form the copyrighted products. Accordingly, any copyrighted computer 

programs contained in Telit’s products described in this instruction manual shall not be 

copied (reverse engineered) or reproduced in any manner without the express written 

permission of the copyright owner, being Telit or the Third Party software supplier. 

Furthermore, the purchase of Telit products shall not be deemed to grant either directly 

or by implication, estoppel,  or in any other way, any license under the copyrights, patents 

or patent applications of Telit or other Third Party supplied SW, except for the normal 

non-exclusive, royalty free license to use arising by operation of law in the sale of a 

product.  

 Usage and Disclosure Restrictions 

7.2.1. License Agreements 

The software described in this document is owned by Telit and its licensors. It is furnished 

by express license agreement only and shall be used exclusively in accordance with the 

terms of such agreement. 

7.2.2. Copyrighted Materials 

The Software and the documentation are copyrighted materials. Making unauthorized 

copies is prohibited by the law. The software or the documentation shall not be 

reproduced, transmitted, transcribed, even partially, nor stored in a retrieval system, nor 

translated into any language or computer language, in any form or by any means, without 

prior written permission of Telit. 

7.2.3. High Risk Materials 

Components, units, or third-party goods used in the making of the product described 

herein are NOT fault-tolerant and are NOT designed, manufactured, or intended for use 

as on-line control equipment in the following hazardous environments requiring fail-safe 

controls: operations of Nuclear Facilities, Aircraft Navigation or Aircraft Communication 

Systems, Air Traffic Control, Life Support, or Weapons Systems (“High Risk Activities"). 

Telit and its supplier(s) specifically disclaim any expressed or implied warranty of fitness 

eligibility for such High Risk Activities. 
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7.2.4. Trademarks 

TELIT and the Stylized T-Logo are registered in the Trademark Office. All other product 

or service names are property of their respective owners.  

7.2.5. Third Party Rights 

The software may include Third Party’s software Rights. In this case the user agrees to 

comply with all terms and conditions imposed in respect of  such separate software 

rights. In addition to Third Party Terms, the disclaimer of warranty and limitation of  

liability provisions in this License, shall apply to the Third Party Rights software as well. 

TELIT HEREBY DISCLAIMS ANY AND ALL  WARRANTIES EXPRESSED OR IMPLIED FROM 

ANY THIRD PARTY REGARDING ANY SEPARATE FILES, ANY THIRD PARTY MATERIALS 

INCLUDED IN THE SOFTWARE, ANY THIRD PARTY MATERIALS FROM WHICH THE 

SOFTWARE IS DERIVED (COLLECTIVELY “OTHER CODES”), AND THE USE OF ANY OR ALL 

OTHER CODES IN CONNECTION WITH THE SOFTWARE, INCLUDING (WITHOUT 

LIMITATION) ANY WARRANTIES OF SATISFACTORY QUALITY OR FITNESS FOR A 

PARTICULAR PURPOSE. 

NO THIRD PARTY LICENSORS OF OTHER CODES MUST BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 

(INCLUDING WITHOUT LIMITATION LOST OF PROFITS), HOWEVER CAUSED AND 

WHETHER MADE UNDER CONTRACT, TORT OR OTHER LEGAL THEORY, ARISING IN ANY 

WAY OUT OF THE USE OR DISTRIBUTION OF THE OTHER CODES OR THE EXERCISE OF 

ANY RIGHTS GRANTED UNDER EITHER OR BOTH THIS LICENSE AND THE LEGAL TERMS 

APPLICABLE TO ANY SEPARATE FILES, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES. 

7.2.6. Waiwer of Liability 

IN NO EVENT WILL TELIT AND ITS AFFILIATES BE LIABLE FOR AY DIRECT, INDIRECT, 

SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY 

INDIRECT DAMAGE OF ANY KIND WHATSOEVER, INCLUDING BUT NOT LIMITED TO 

REIMBURSEMENT OF COSTS, COMPENSATION OF ANY DAMAGE, LOSS OF 

PRODUCTION, LOSS OF PROFIT, LOSS OF USE, LOSS OF BUSINESS, LOSS OF DATA OR 

REVENUE, WHETHER OR NOT THE POSSIBILITY  OF SUCH DAMAGES COULD HAVE BEEN 

REASONABLY FORESEEN, CONNECTD IN ANY WAY TO THE USE OF THE PRODUCT/S OR 

TO THE INFORMATION CONTAINED IN THE PRESENT DOCUMENTATION, EVEN IF TELIT 

AND/OR ITS AFFILIATES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES 

OR THEY ARE FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY. 
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 Safety Recommendations  

Make sure the use of this product is allowed in your country and in the environment 

required. The use of this product may be dangerous and has to be avoided in areas where:   

• it can interfere with other electronic devices, particularly in environments such as 

hospitals, airports, aircrafts, etc. 

• there is a risk of explosion such as gasoline stations, oil refineries, etc. It is the 

responsibility of the user to enforce the country regulation and the specific 

environment regulation. 

Do not disassemble the product; any mark of tampering will compromise the warranty 

validity. We recommend following the instructions of the hardware user guides for 

correct wiring of the product. The product has to be supplied with a stabilized voltage 

source and the wiring has to be conformed to the security and fire prevention regulations. 

The product has to be handled with care, avoiding any contact with the pins because 

electrostatic discharges may damage the product itself. Same cautions have to be taken 

for the SIM, checking carefully the instruction for its use. Do not insert or remove the SIM 

when the product is in power saving mode. 

The system integrator is responsible for the functioning of the final product. Therefore, 

the external components of the module, as well as any project or installation issue, have 

to be handled with care. Any interference may cause the risk of disturbing the GSM 

network or external devices or having an impact on the security system. Should there be 

any doubt, please refer to the technical documentation and the regulations in force. Every 

module has to be equipped with a proper antenna with specific characteristics. The 

antenna has to be installed carefully in order to avoid any interference with other 

electronic devices and has to guarantee a minimum distance from the body (20 cm). In 

case this requirement cannot be satisfied, the system integrator has to assess the final 

product against the SAR regulation.  

The equipment is intended to be installed in a restricted area location. 

The equipment must be supplied by an external specific limited power source in 

compliance with the standard EN 62368-1:2014. 

The European Community provides some Directives for the electronic equipment 

introduced on the market. All of the relevant information is available on the European 

Community website: 

https://ec.europa.eu/growth/sectors/electrical-engineering_en  

 

https://ec.europa.eu/growth/sectors/electrical-engineering_en
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8. GLOSSARY 

 

APN 

Access Point Name – It’s the gateway name between a GSM, GPRS, 

3G or 4G mobile network and another computer network (usually 

the internet) 

IMEI 
International Mobile Equipment Identity- It’s aunique number that 

is associated with all 2G-5G devices 

IMSI 
International Mobile Subscriber Identity- It’s a unique number that 

is associated with all SIM cards 

I/O Input Output 

JSON 

JavaScript Object Notation- It’s a text-based data interchange 

format designed for transmitting and storing structured data, both 

human readable and machine readable 

LWM2M 

LightWeight Machine to Machine- IoT application protocol 

designed for bidirectional communication between devices and a 

central server 

PDP 

Packet Data Protocol- It’s a protocol that defines a specific data 

structure that allows the device to communicate using the Internet 

Protocol 

RTC Real Time Clock 

SIM Subscriber Identification Module 

USB Universal Serial Bus 

URC 

Unsolecited Result Code- It’s the message returned by the mobile 

equipment (the modem) that is not a direct result of an AT 

command. It could be a soft interrupt or the response of an AT 

asynchronous command 

XML 

eXtendible Markup File- It’s a markup language that defines a set 

of rules for encoding documents in a format that is both human-

readable and machine-readable 

WWAN 
Wireless Wide Area Network, is a form of wireless network usually 

associated to mobile bradband connection. 
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